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Edit Window
3D shapes are drawn and edited in the Edit Window. This works in a similar way to most standard vector 
packages, but in three dimensions. Shapes can be created by selecting a shape tool and then drawing the shape. 
They can be dragged onto the screen from a selection of shapes, or they can be defined using a wizard and 
typing in the dimensions.

Output Window
The Output Window can display either nets of shapes created in the Edit Window, or 1st angle, 3rd angle, or 
single view Projections. It’s called the Output Window because what you see in this window is what gets output 
to the printer or Silhouette machine. The Output Window acts like a print preview, allowing the user to place 
shapes as they will appear on the printout.

Switching between the windows
The bar separating the Edit and Output Windows can be moved to allocate more space to one and less to the 
other. Alternatively, three buttons are provided to switch between Edit Window only, both Edit and Output 
Windows, and Output Window only modes. These icons are mirrored by the options in the Window menu.

Overview

Digital Cutting Machines for Schools
Silhouette ModelMaker™ educational software enables students to design and manufacture models from 
3D shapes like cubes, cones, prisms, and pyramids to make boxes and simple models like buildings and space 
rockets. It gives students a hands-on design and making experience, which enriches Science, Technology, Engi-
neering, and Math in STEM education. It can provide students a simplified taste of real world engineering and 
commerce scenarios. 

Silhouette ModelMaker™ gives pupils the chance to be thinkers, planners, problem solvers, designers, inven-
tors, mathematicians, and engineers! 

Design it. Design a 3D shape on the computer with Silhouette ModelMaker and display its geometric net, 
which is an unfolded, segmented version of the 3D shape.

Print it. Print the geometric net generated by Silhouette ModelMaker on cardstock using a photo quality printer.

Make it. The printed geometric net is processed by a Silhouette cutting machine, which scores, perforates, and 
cuts the net to form fold and cut lines. The trimmed net is then used to build the model.

Section 1: Basics

A Tour of Silhouette ModelMaker™

Silhouette ModelMaker™ Main Screen
The main screen of ModelMaker is divided into two parts: the Edit Window and Output Window. These are 
separated by a bar which can be dragged to adjust their relative sizes.

Window Control 
Buttons

Output Window

Edit Window

Design it, Print it, and Make it! 

Silhouette ModelMaker main screen showing the basic tools layout 
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Shapes in Silhouette ModelMaker™
The Shapes Toolbar to the left of the Edit Window contains a button for each type of shape.

Drawing Shapes
Silhouette ModelMaker™ uses 3D shapes to 
design models on the screen. Either a single shape 
can be drawn and manipulated, or lots of different 
shapes can be combined to make a more complex 
3D model. 

 

This model of a Saturn V rocket was drawn using 
mainly cylinder shapes with images placed onto 
them. The command module and the engines were 
drawn using the frustum of cone shape.

Quick Tip

Some of the shapes have a drop down menu 
revealing other variants of the shape that can 
be selected to draw.

Edit Window
All shape drawing and editing is done in the Edit Window. The window provides a 3D space to lay the shapes 
out, move them around, rotate, stretch and scale them. There are three visible axes and a grid to help position 
all the shapes in the right place. They can be grouped, cloned, colored, and rendered with pictures.

The default view for the Edit Window is the Left Corner View, and camera buttons allow the view to be changed to 
the top, front and right side views. Other camera views are available in the camera menu and can also be dis-
played permanently by setting them in preferences.

The main screen can be displayed with a basic, intermediate or advanced toolbar layout, selected using the 
dropdown Tools menu. An overview of the main screen with all the toolbar buttons is illustrated below.

Window Control  
Buttons

Output Window

Output Window Control ButtonsEdit Window Control Buttons

Drawing Tools

Edit Window

The green button on the right takes the user inside the 3D model, transforming it into a virtual where the 
user can walk around and see all the different parts of the design close-up.

Go Inside

All the Edit Window camera view buttons

Cuboid

Wedge

Cylinder

Frustum of Cone

Cone

Sphere

Regular Prism*

Frustum of Pyramid*

Pyramid*

Transition Piece*

Irregular Prism 

Rotational Shape

Torus

Platonic Shapes

*Use the drop-down menu to choose shape of polygon. 

Saturn V Rocket

Silhouette ModelMaker main screen showing the advanced tools layout



Section 2: Drawing Shapes Section 2: Drawing Shapes6

Silhouette ModelMaker™Silhouette ModelMaker™

7

Drawing a cone shape:

Select the cone tool. Click on the screen to start drawing its 
base. Drag the mouse to draw out the base diameter, and 
click to set the base. Then drag the mouse upwards to give 
the cone height, which is its third dimension. Click to finish.

Drawing a sphere shape:

Select the sphere tool and click on the screen to start 
drawing. Drag the mouse to draw out its diameter. Click to 
finish.

Drawing a regular prism shape:

Select the regular prism tool. Click on the screen to start 
drawing its base. Drag the mouse to draw out the base,  
and click to set it. Then drag the mouse upwards to give 
the prism height. Click to finish. Use the dropdown menu 
on the prism tool to choose the number of sides to the end 
faces. 

Drawing a frustum of a pyramid shape:

Select the frustum of a pyramid tool. Click on the screen 
to start drawing the base. Drag the mouse to draw out the 
base, and click to set it. Then drag the mouse upwards to 
give the pyramid height. Click to finish. 

 

When the frustum of a pyramid is selected, as shown in the 
illustration, two red control handles are displayed on top 
of the wedge. Use these handles to adjust the pitch of the 
sides of the shape. Use the dropdown menu on the pyramid 
tool to choose the number of sides to the top and base. 

Section 2: Drawing Shapes

Shapes can be drawn in three ways:

ff Select a shape tool and draw it with the mouse.

ff Drag a library shape on to the screen.

ff Use the shape wizard and type in dimensions.

Drawing a cuboid shape:

Select the cuboid tool. Click on the screen to set a corner 
point of the base. Then drag the mouse to draw out the base, 
and click to set the base. Drag the mouse again, upwards or 
downwards, to give the cuboid height, or its third dimension. 
Click to finish.

Drawing a wedge shape:

Select the wedge tool. Click on the screen to set a corner 
point of its base. Then drag the mouse to draw out the 
base and click to set it. Drag the mouse again, upwards or 
downwards, to give the wedge height. Click to finish. When 
the wedge is selected, as shown in the illustration, two red 
control handles are displayed on top of the wedge. Use these 
handles to adjust the pitch of the sides of the shape.

Drawing a cylinder shape:

Select the cylinder tool. Click on the screen to start drawing 
its base. Drag the mouse to draw out the base, and then click 
to set the base. Drag the mouse again, upwards or down-
wards, to give the cylinder height. Click to finish.

Drawing a frustum of a cone shape:

Select the frustum of a cone tool. Click on the screen to start 
drawing its base. Drag the mouse to draw the base, and click 
to set the base. Drag the mouse upwards to give the shape 
height, and click to set the height. Then drag the mouse again 
to set the diameter of the top face. Click to finish.

Cuboid

Wedge

Cylinder

Frustum of 
a Cone

Cone

Sphere

Regular

Frustum of 
a Pyramid
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Drawing a rotational shape:

Select the rotational tool. Click on the screen to start 
drawing its base. Drag the mouse to draw out the diameter 
and click to set it. Drag the mouse upwards to give the 
shape height. Click to finish.

At this point, the shape looks like a cylinder. ModelMaker 
then animates the shape to position its side view square 
on to the viewer, ready for editing. Use the mouse to add 
points to the shape by clicking on the white perimeter line. 
Move points with the mouse to create the desired shape, 
like a wine glass. Click the FINISH button in the pop-up 
toolbar.

Drawing a torus shape:

Select the torus tool. Click on the screen to start drawing. 
Drag the mouse to draw out the diameter. Click to finish. 
When the torus is selected, as shown in the illustration, 
two red control handles are displayed on inner radius of 
the shape. Use these handles to adjust the diameter of the 
cross section of the torus. 

Drawing a platonic solid shape:

Select the platonic shape tool. Click on the screen to start 
drawing the default shape, a dodecahedron. Drag the 
mouse to draw out its diameter. Click to finish.

Use the dropdown menu on the platonic shape tool to 
choose the number from any of the five platonic solids 
to draw: dodecahedron, tetrahedron, hexahedron, octahe-
dron, or icosahedron.

Quick Tip

Keep the shapes small. When learning ModelMaker it is best to keep the shapes 
quite small, around two inches wide. It is much easier to see what is happening and 
the shape NET will fit on a single page.

Drawing a pyramid shape:

Select the pyramid tool. Click on the screen to start drawing 
its base. Drag the mouse to draw out the base, and click to 
set it. Then drag the mouse upwards to give the pyramid 
height. Click to finish. Use the dropdown menu on the 
pyramid tool to choose the number of sides to the top and 
base. 

Drawing a transition shape:

Select the transition tool. Click on the screen to start 
drawing its base. Drag the mouse to draw out the base, 
and  click to set it. Drag the mouse upwards to give the 
transition piece height. Click to finish.

A drop down menu for the transition tool provides options 
to create a transition shape with different end faces. For 
example, choose to draw a shape with a square face at one 
end and a pentagonal base at the other end.

Drawing an irregular prism shape:

Select the irregular prism tool. Click on the screen to set a 
corner point of the base. Drag the mouse to draw out the 
base, and click to set it. Then drag the mouse upwards to 
give the cuboid height. At this point, the prism looks like a 
cuboid shape.

ModelMaker then animates the shape to position its end 
face square on to the viewer, ready for editing. Use the 
mouse to add points to the shape by clicking on the white 
perimeter line. Move points with the mouse to create the 
desired shape, like a staircase. Click the FINISH button in 
the pop-up toolbar.

Pyramid

Transition

Irregular 
Prism

Rotational 
Shape

Torus

Dodecahe-
dron
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The default Edit Window shows a view of the drawing area looking down from the left corner. In this view, the 
grid provides a solid floor and all the shapes drawn in this view are automatically drawn on the floor. They can 
be moved afterwards, but they are initially drawn on the floor.

Section 3: Drawing in 3D

We live in a 3D world with width, height, and depth dimensions. Drawings created in Modelmaker are also in 
3D. It can be inconvenient the that the computer screen only has two dimensions. It has a width dimension and 
a height dimension, but it doesn’t have a depth dimension. The fact that the screen is 2D presents a hurdle in our 
efforts to draw a 3D model. ModelMaker helps to overcome the lack of real depth on the screen by drawing in a 
world with virtual depth. In this world, models are drawn with their dimensions adjusted to show perspective, so 
the dimensions at the rear of the model are smaller than those at the front. Also, models that are drawn towards 
the rear of the screen are smaller.

This method of drawing combines to give the appearance of a 3D dimensional space to work within. Think of 
the railway track effect in the real world. Imagine standing on a railway track and looking along the track into 
the distance. The part of the track closest is wide, but the track in the distance is narrow. Yet we all know that 
the real dimensions of the track are the same, whether close or far away. ModelMaker mimics this effect to give 
the illusion of a 3D world.

Creating this illusion of a 3D space is just a part of the story. When placing 3D shapes on to the 2D screen, it is 
impossible to accurately gage exactly where to put the shape. Look at the illustrations above. In the left-hand 
drawing, the user has intended to draw three shapes on a flat and level plane. The right-hand drawing shows the 
same model from the side view. See how all the shapes are at different heights?

To help overcome this problem and to make 3D drawing easy and more intuitive, ModelMaker uses techniques 
to seamlessly guide the user when drawing 3D models. The first of these aids is the solid grid in the default 
drawing window. The grid acts as a floor for 3D shapes.

A drawing with three shapes on a flat plane? The same drawing looking from the side
Once a shape has been drawn on the floor, it will remain on the floor even when moving it around the screen. 
This makes it really easy to build models when combining lots of shapes.

To help further, the grid can be locked so that shapes snap to the squares. The dimensions and number of grid 
squares can be adjusted to suit different preferences. For example, the default grid might comprise of 1  inch 
squares divided up into sixty-four (8 x 8) smaller squares. But if all the shapes get drawn on the solid grid floor, 
what happens if one wants to place shapes on top of others? In this case, if ModelMaker detects that a shape is 
being drawn on top of another shape, it will cause the existing shape to become the “floor”.

When the grid is displayed in the default drawing view, it acts as a solid floor for newly drawn shapes. 
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Quick Tip

How-to draw a cuboid shape.

1. Select the cuboid shape tool.

2. Click to set the corner of the cuboid.

3. Drag the mouse to draw the base of the cuboid.

4. Click to finish drawing the base.

5. Drag the mouse up to draw the height.

6. Click to finish.

The illustration on the left shows 3D shapes sitting on the floor. These shapes can be moved around, but they 
will stay on the floor. They can, of course, be moved in the Y axis by using special grab handles to move the 
shape directly up or down.

The illustration on the right shows shapes drawn on top of each other. In this case, ModelMaker detects when 
a shape is going to be drawn on top of another and causes the existing shape to become the floor for the 
new shape. Once the top shape is drawn, the height at which it sits acts as the floor for that particular shape 
throughout the whole 3D space. The height of the shape is easily changed using grab handles.

The grid presents itself as a solid floor, but that doesn’t mean that the floor is always in the same place. In the 
illustration above, the top of an existing shape became the floor. In the illustrations below, a blue grab handle at 
the center of the grid is being used to change its height and thus the height of the floor for the next shape being 
drawn.

3D shapes on the grid floor 3D shapes on top of each other

3D shapes on the grid floor The grid floor adjusted to a new height, becoming 
the floor for the next shape to be drawn 
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In the same way that ModelMaker will detect when 
the mouse is on top of an existing shape and will 
display drawing guides to help draw the new shape 
on top of it, similar guides are displayed when the 
mouse is hovering by the side of an existing shape. 

These illustrations show the sequence of events 
when the mouse hovers close to the side of an 
existing shape. In this case, guides are displayed and 
the cursor has turned orange, which means that the 
first click will snap the corner of the new shape to the 
corner of the existing one.

Quick Tip

Draw a shape adjoined to another in the front 
view.

1. Select the Edit Window front view camera.

2. Click to set the corner of the shape.

3. Drag mouse to draw the front face.

4. Click to finish front face.

5. Edit Window rotates to show side view.

6. Drag mouse to draw side face.

7. Click to finish drawing side face.

8. Edit Window reverts back to the front view.

The illustrations below show what the mouse cursor looks like when drawing a shape. In the left-hand illustra-
tion, the mouse cursor is blue and a shape is about to be drawn on the floor. In the right-hand illustration, the 
mouse cursor has been moved so that it hovers over a shape. In this case, a set of guides has appeared on top 
of the shape.

When the mouse cursor turns orange, it indicates that any point drawn with a click of the mouse will snap to a 
logical point on the shape below. A logical point might be the corner, middle, or the center of a side. When the 
cursor is blue, one can choose a position to click and draw. When a new shape is being drawn, all the existing 
shapes become transparent, which helps to see what is happening during construction of the new shape.

A new shape is about to be drawn on 
the grid floor

A new shape is about to be drawn on 
top of an existing shape

The base of the new shape is being 
drawn (click to drag)

Drag the mouse up and click to complete 
the shape on top of an existing one

When the mouse is 
close to the side of 
a shape, guides are 
displayed to help 

draw the new shape 
attached to the side 
of the existing one. 

The new shape is 
complete (drag click) 
and the two shapes 
are joined exactly 

together.  

The side of the new 
shape is drawn  

(click drag click).

It’s easy to draw 
shapes joined 

together in this 
virtual 3D world.
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Once the front face of the shape has been drawn, (by clicking to set the first corner, dragging the mouse to form 
the size of the front face, and then clicking to finish) the entire Edit Window will automatically rotate to display 
the side view of the model. It rotates quite slowly to make it easy to see what is happening.

If there are any other shapes in the model when the new shape is being drawn, these shapes will become 
transparent making it easier to see the shape that is in the process of being drawn. Once the front face has been 
drawn and the Edit Window has rotated to display the side view, the “side view” of the front face will remain on 
the mouse cursor. The “side view” of the front face can then be moved back and forth by moving the mouse, and 
it can be placed in the desired position by clicking. 

Having set the “side view” of the front face in position, dragging the mouse will draw the side view of the shape, 
giving it depth. Click to finish. The Edit Window rotates from the side view back to the front view, and the shape 
is complete.

Section 4: Drawing in Different Views

Drawing in Front, Side, Top, or Bottom Views
When ModelMaker displays the default view, looking down at the model from the left corner, the grid will act as 
a floor making it easy to draw shapes in 3D and combine them to make models. But when the Edit Window is in 
the front, side, top, or bottom views, it is impossible to visualize where the grid is in terms of how far or close it is 
to the viewer. In a corner view where one can see shapes sitting on the grid, it is easy to move them around and 
to draw new shapes. But, in the front view, while it is easy to draw a shape with width and height (a 2D shape), 
is not possible, by eye, to draw and accurate depth dimension.

Drawing 3D shapes in the front view 
When drawing in the front view, ModelMaker switches automatically 
to a different method of drawing shapes, allowing the user to draw a 
3D shape and place it exactly in the desired place. This requires more 
skill than drawing shapes on the grid floor, but it does provide an accurate 
method to draw and place shapes at exact coordinates in 3D space and 
to draw shapes next to existing ones.

The process to draw shapes when the Edit Window shows the front view 
is a two stage process:

1. Draw the front face of the shape. When drawing a cuboid, 
click to set the first point, then drag the mouse and 
click to complete the front face. At this point, the entire 
Edit Window rotates to show the side view of the model.  
The “side view” of the front face just drawn is on the 
mouse cursor.

2. Draw the side of the shape. Without touching any of 
the mouse buttons, move the mouse to position the 
“side view” of the front face in the desired place and click 
to set its position. Dragging the mouse will then draw the 
side view of the shape, giving it depth. Click to finish. The 
Edit Window reverts back to the front view. The shape 
just drawn still looks like a flat 2D shape when looking 
at it from the front view, but one can select another view 
by clicking different camera buttons to see the 3D shape 
that’s been drawn.

Click and drag the mouse to draw the 
front face of the shape, then click to 

finish the face. 

Edit Window rotating from the front 
view to the side view. 

Edit Window showing the “side view” of  
the front face, looking like a vertical line. 

The “side view” of the front face is set in place by click-
ing, then the face dragged out to complete the shape. 

Edit Window rotating between the side Back in the front view showing the 
completed 3D shape from the front
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Quick Tip

Draw a shape adjoined to another in the front view.

Assumes that a shape, a cuboid for example, already 
exists in the Edit Window.

1. Select the Edit Window front view camera.

2. Hover the mouse over the shape to reveal guides.

3. Click on one of the hot spots (cursor is orange).

4. Drag mouse to draw the front face.

5. Click to finish front face.

6. Edit Window rotates to show side view.

7. Drag mouse to draw side face.

8. Click to finish drawing side face.

9. Edit Window reverts back to the front view.

When the Edit Window is showing the front view, one can draw 
shapes by drawing the front face and then drawing the side face after 
the window has rotated to show the side view. 

When there are already shapes in the scene, new shapes drawn will 
attach to existing ones. The process is similar to that used when 
drawing on top of shapes that are sitting on the grid floor. When Mod-
elMaker detects the mouse hovering in front of an existing shape, a 
set of drawing guides will be displayed on the front of the existing 
shape. Any shape drawn while these guides are visible will be drawn 
joined onto that shape. Hot spots on the guides are identified by the 
mouse cursor changing color to orange.

Clicking the mouse when the cursor is orange will set the corner of 
the new shape and snap it to the corresponding place on the existing 
shape. Using the hot spots makes it easy to draw shapes while accu-
rately butting them against existing ones.

Front view of an existing 3D 
shape in the Edit Window 

When the mouse hovers in front of the 
shape a new set of guides is displayed. 

Click drag and click again to draw 
the front face of the new shape. 

Summary of the two drawing methods
The process for drawing shapes when the Edit Window is displaying the front 
view is a two stage process, described in the previous few pages. First one 
draws the front face. Then the window is automatically rotated to show the 
“side view” of the front face. Then, the side of the shape is drawn using mouse 
to complete the shape. 

This method for drawing 3D shapes is also used when the Edit Window is set 
to display the side view, top view, or the bottom view of the model. 

When the Edit Window is displaying a corner view, where one is looking down 
at the 3D model, ModelMaker uses a simple process to draw 3D shapes by 
using the grid as a floor.

Quick Tip

When drawing a shape on top of or next to another shape, 
ModelMaker displays drawing guides.

Hot Spots are revealed when the cursor turns orange. Clicking 
this hot spot will snap that part of the new shape to the existing 
one. This makes it easy to join shapes together accurately.

Edit Window rotating from the 
front view to the side view. 

The “side view” of the front face 
of the shape being drawn. 

Edit Window rotating from the 
side view back to the front view. 
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Shape Creation Wizard
As well as drawing shapes using the mouse, ModelMak-
er has a simple wizard to draw shapes using dimensions 
and coordinates typed on the keyboard.

Click the Shape Creation Wizard to display the wizard 
box. Select one of the shapes to make and type in the di-
mensions. The illustration shows a 2 x 2 x 2 inch cuboid 
drawn using the wizard. 

The Shape Creation Wizard can be used to draw any of 
the shapes available in ModelMaker. 

Each shape is defined by the user in terms of dimensions 
and coordinates, and some of the more complicated 
shapes like the irregular prism are drawn by defining the 
coordinates for each of the points in the shape.

Quick Tip

The coordinates for each shape are relative to the 
center of the shape.

A cuboid with dimensions 1 x 1 x 1 inch placed in the 
very center of the scene will have the coordinates:

X=0  Y=0  Z=0

A cuboid with dimensions 1 x 1 x 1 inch placed in the 
center of the scene, but sitting on top of the grid will 
have the coordinates:

X=0  Y=0.5  Z=0

Shape creation wizard 

Using the shape creation wizard to plot the points of an 
irregular prism.

QuickShapes
In addition to drawing shapes using the mouse and by using the Shape 
Creation Wizard, Modelmaker has a small library of QuickShapes 
which can be dragged onto the screen.

Select the QuickShapes button to open a window containing the 
shapes.

Drag shapes onto the screen using the mouse. The library contains a 
small selection of simple shapes and a folder of buildings.

Quick Tip

When drawing a model one can select all the different 
camera views to see the model from different angles.

By clicking the Go Inside button, one can go inside the 
model and walk around using the arrow keys.

QuickShapes

Go Inside
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Select a Shape
To apply any actions to a shape, it must first be 
selected. This is done simply by clicking on the shape 
with the mouse. If the select button is active when a 
shape is clicked, it is selected and bounded by a box 
with handles to stretch, scale, and move it. If the 
rotate button is selected when the shape is clicked, it 
will selected and bounded by a box with handles to 
change the axis, rotate, and move it.

The following actions/attributes can be applied to a 
selected shape:

1. Stretch (in select mode)

2. Scale (in select mode)

3. Translate (in select mode)

4. Rotate (in rotate mode)

5. Color

6. Texture

7. Copy

8. Clone

9. Lock

10. Delete

11. Edit

12. Viewed up close

13. Wireframe or solid

14. Grouped with another shape

15. World or shape axes

When a single face is selected, all the other faces are 
made transparent to make it easier to see which face 
is selected. Selected faces can be colored or textured 
and can be used in conjunction the texture orientation 
controls.

Quick Tip

Selecting a face is useful during operations such as 
changing the orientation of an image on the face. 
But to color or texture a face, it doesn’t need to be 
selected. Just drag the color or image file onto a 
face.

Select button

Scale handlesTranslate handlesStretch handles

Select a face button

Quick Tip

Drawing shapes equidistant around the center of the 
window makes it easier to see what’s going on and easier 
to see the model when rotating the window.

Quick Tip

Use this button to zoom in on small shapes in the 
drawing.

Quick Tip

You can go inside the model and walk around using 
the arrow keys and look up and down using the A 
and Z keys. This is especially useful when making 
large models like a street scene. 

Edit Window controls
The Edit Window can be rotated, panned, zoomed, and reset to its home position. It can be viewed from a 
selection of different camera angles and displayed in either orthographic or perspective.

The Edit Window can also be used to zoom in on a selected shape.

Pan

Zoom inZoom out Zoom in/out

Zoom close into the select shape

Reset Edit Window 
to home position

Select camera views Go inside

Edit Window rotate controls

Perspective or Orthographic view
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Coloring Shapes
The color palette window contains:

1. Color palette.

2. RGB/HSL color picker.

3. Image library.

4. Image orientation controls

5. Wireframe button.

6. Solid button.

7. Browse for images.

Quick Tip

Color or texture a shape:

1. Select the shape then click a color or image.

2. Drag a color onto a face.

3. Drag an image file from the hard disc onto a face.

Color Palette

Wireframe or Solid Shapes

Image orientation controls

Browse for images

Drop down menu for image library

Camera views
There are eight camera view buttons and one to take the viewer inside the 
model to walk around. Other controls allow the model to be rotated to any angle 
using the mouse.  Views be toggled between perspective and orthographic.

Go inside

Bottom view

Top view

Right side view

Back viewLeft corner view (default)

Front view tilted Left side view

Front view
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Orthographic and Perspective views
Shapes can be drawn and viewed in either an orthographic or a 
perspective view.

Orthographic view
The orthographic view is when the shape is displayed with its di-
mensions exactly as they are in the real world.

Look at the model of the wooden crate. It is a cuboid, and the 
dimensions of its front and back sides are exactly the same. If it 
were a real wooden crate, then it’s obvious that the actual dimen-
sions remain the same wherever it is, near or far from the viewer. 
Although the dimensions in this orthographic view are accurate, 
the wooden crate looks wrong. This is because when we view an 
object in the real world, our eyes take into account the distance 
we are from the object. The further away an object, the smaller it 
looks. If the front of an object is closer to the viewer than its back, 
the dimensions at the front “look” bigger than the same dimen-
sions at the back.

Perspective view
The perspective view is when shapes are drawn in a way to simulate 
how we perceive objects viewed through the lens of our own eyes, 
or how they appear in the real world. Shapes in ModelMaker are 
drawn in a way to provide the illusion of depth or distance. Imagine 
a railway track; a railway track comprises a pair of parallel rails and 
when one looks along the rails going off into the distance the they 
appear to converge.

The gap between the rails is identical at both ends of the track, 
near and far, but in reality the gap between the rails at the near end 
looks much wider than the gap at the far end. In the far distance 
they seem to converge to a point!

Quick Tip

Toggle the perspective and orthographic buttons. Which view is real? And 
which one looks real?

This orthographic view of a wooden crate looks 
wrong. The edge at the back looks wider than 

the edge at the front!

In this perspective view the box is drawn with 
the back edge narrower than the front edge, 

providing the illusion of depth.

Shape Parameters
All the shapes used in ModelMaker can be modified in 
some way by changing its parameters. For example, one 
can change the shape and size of a cuboid by modifying 
its width, height, and depth parameters.

Cuboid Parameters = W, H, D

A cylinder can be modified by changing its radius and 
height parameters.

Cylinder Parameters = R, H

A platonic solid shape can be modified by changing the 
length of one of its sides (or a sphere by changing its 
radius).

Quick Tip

You can change the size and shape of a shape by changing its parameters using the keyboard.

Right-click on a shape to display its menu.
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Shape Position
ModelMaker is used to draw 3D shapes and to position them in 
a 3D space. The actual position of a shape in 3D space can be 
defined by a set of coordinates.

Position is defined by X, Y, and Z coordinates.

X, Y, and Z refer to the axes:

X is a horizontal axis (left to right).

Y is a vertical axis (top to bottom).

Z is a depth axis (in and out of the screen).

The coordinate at the very center of the screen is:

X = 0, Y= 0 , Z = 0

ModelMaker references all coordinate data to the center of the 
shape.

Shape Properties
The properties of each shape can be displayed by right clicking 
on a shape and selecting the Properties option. 

The shape properties pane contains sub-headings to display 
properties relevant to that shape. A cuboid will display proper-
ties such as:

ff Description

ff Formula

ff Area

ff Volume

Other shapes have different properties. A platonic solid shape, 
for example, will show the type of face, number, and length of 
sides, vertices, etc. 

Quick Tip

You can change the size and shape of a 
shape by changing the values in its proper-
ties pane using the keyboard.

Right-click on a shape to display its menu, then 
click “Position”.

Right-click on a shape to display its menu, then 
click “properties”.

Shape Properties (continued)
Here are a few examples of the shape properties panes found in ModelMaker.

Translate a shape
Any shape can be translated, or moved with the mouse. A 
shape’s position can also be translated accurately by using 
the keyboard to type values into the translate pane.

Right-click a shape and select “Translate” to display the 
pane. Shapes can be translated in the X, Y, and Z axes by 
applying the values set in the translation pane. Values can 
be positive or negative ones. When moving a shape in the 
Y axis, for example, it can be translated upwards or down-
wards if the value used is negative.

When a translation is applied to a shape, the values set in 
each of the X, Y, and Z fields are applied at the same time. 
More ways to translate a shape are on the next pages.
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Translate a shape (continued)
Any shape can be translated (or moved using the mouse). Simply drag a 
shape with the mouse to a different part of the screen. However, because 
the screen is a flat 2D screen and the shape is inside a 3D world, it is not 
possible to accurately move a shape accurately without some aid.

In addition to typing values into the translate pane to move the shape in 
the three X, Y, and Z axes, ModelMaker appends translate handles to the 
bounding boxes on each shape or group of shapes. These can be used to 
move the shape.

There is a translate handle in the middle of each edge of a bounding box. It is 
used to translate the shape in the direction of that edge. For example, when 
a shape is translated using the handle on a vertical edge of the bounding 
box, the shape will move exactly vertical.

If a shape has not been rotated in any way since it was made, then the trans-
late handles can be used to move the shape in each of the X, Y, and Z planes.

Quick Tip

To draw a tidy row of three columns, draw one column and select 
it. Then click the clone button twice. Use the translate handle on 
the X axis to drag the cloned copies off of the original column and 
translate them to the new position.

Translate or move handles.

Clone button

Rotate a shape

Shapes can be rotated by:

ff Dragging a rotate handle with the mouse.

ff Applying a value in the Rotate pane.

When the Rotate button is active, selected shapes will be bounded 
by a box with green handles and axes handles.

Click on an axis handle to determine which axis to rotate the 
shape. The rotate the shape by dragging the green handles. A more 
accurate way to rotate the shape is by applying a value typed into the  
Rotate pane. The pane can be accessed by right-clicking the shape 
and choosing the Rotate option or via the Arrange menu.

Scale a shape

Shapes can be scaled by:

ff Dragging a scale handle with the mouse.

ff Applying a value in the Scale pane.

When the Select button is active, selected shapes are bounded by 
a box with scale handles at each corner. The white handles in the 
middle of each face are for stretching the shape.

Dragging a handle on the corner will scale the shape while dragging 
the middle will stretch the shape in the direction of that face. A 
more accurate way to scale the shape is by applying a value typed 
into the Scale pane. The pane can be accessed by right-clicking the 
shape and choosing the Rotate option or via the Arrange menu.
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Stretch a shape
Shapes can be stretched by:

ff Dragging a stretch handle with the mouse.

ff Applying a value in the Stretch pane.

When the select button is active, selected shapes 
will be bounded by a box with white scale and 
stretch handles attached. Stretch the shape in 
the direction of the face by dragging the stretch 
handles.

A more accurate way to stretch the shape is by 
applying a value typed into the Stretch pane. The 
pane can be accessed by right-clicking the shape 
and choosing the Rotate option or via the Arrange 
menu.

Quick Tip

If you stretch or rotate a shape 
by hand and make a mistake, 
use the Undo button to go back 
and try again. The Undo button 
can undo all the actions carried 
out since the last undo/redo.

Shape Axis
Shape axis means that the X, Y, and Z axis of the shape will remain relative to 
the shape even after it has been rotated.

In the illustration, the red shape has been rotated to rest between the vertical 
and slanted purple shapes. 

The axis of the red shape has been set by the Shape Axis button. Using the 
translate handles, the shape is moved accurately along the face of the slanted 
shape.

World Axis
The world axis is X, Y, and Z axis of the whole 3D scene, and it never changes.

In the illustration the red shape has been rotated to rest between the vertical 
and slanted purple shapes. 

The axis of the red shape has been set by the World Axis button. Using the 
translate handles the shape is moved accurately up the face of the vertical 
shape.

Quick Tip

To move a rotated shape in the X, Y, and Z axes (horizontally, vertically, and 
in depth), select the shape and set its axis to World Axis. Use the mouse to 
drag the translate handles.

Shape AxisWorld Axis
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Section 5: Output Window

The output window is like a print preview page; whatever is displayed in the Output Window is what is sent to 
the printer. The Output Window displays nets and projections as they appear on the page to be printed or cut 
with a Silhouette.

Quick Tip

Initially, try to limit the size of shapes so that their nets 
fit onto one page. A cuboid 2 x 2 x 2 inches for example 
will easily fit onto a page.

The output window can be set to display either the nets or the projections of shapes. 

Shape Nets
Nets of shapes displayed in the Output Window are directly related to the 3D shape drawn in the Edit Window. 
The figure below shows a cuboid and its associated net. Nets are the 3D shape unfolded and flattened. When 
the cuboid is scaled larger or smaller, the net will display larger or smaller, as well.

.The net can be printed, folded, and glued to make the original 3D shape. Nets of shapes would be almost 
impossible to make into a physical 3D model, so tabs are added to the faces of each net to help adhere sides  
together while making the physical model.

Whatever one designs in the software, it can be printed out, cut and scored with fold lines, and then constructed 
in the real world from cardstock. Here are some of the nets found in ModelMaker.

When a 3D shape is drawn in the Edit Window, its associated net 
is drawn automatically and placed in the Output Window. Nets are 
placed in an orderly layout, and can be rotated and moved to make 
the best use of the space on the page.

Auto-arranging Nets 
Sometimes there are lots of nets and the layout can become confus-
ing. In this case, the Auto-arrange Nets button is useful for organizing 
the nets neatly.

Auto-arrange Nets

Fit to window
Drag zoom

If the nets get into a mess...

… click the Auto-arrange Nets button.
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Net Permutations
The cuboid, tetrahedron, and octahedron have a choice of net permutations. These are selected by right-clicking 
on the net to display a menu of options. Here are some different permutations for the cuboid net.

In Silhouette ModelMaker™, all the nets of 3D Shapes are 
displayed in the Output Window and can be printed to 
make 3D paper models.

Nets can be rotated and moved to better fit the paper. 
Different net permutations can be displayed for shapes 
like the tetrahedron, hexahedron, octahedron, and cuboid 
shapes.

All the shape nets can be printed onto paper or cardstock, 
scored and trimmed using a Silhouette machine, and folded 
and glued to make 3D paper models. A Saturn V rocket 
can be made from cylinder shapes, or a new package for 
after-dinner mints could be made from cuboid shapes.

Cuboid nets be displayed with different permutations of the faces

The tetrahedron and octahedron have a couple of 
different permutations

Right-click net menu

Separating Nets
In addition to being able to move and rotate nets to achieve a better fit on the page, nets can also be broken into 
two parts. Separating a net into two parts provides more flexibility and can save a lot of space.

Quick Tip

If a net is too big for the page, separate it 
into parts and move them around to fit.

To place nets more efficiently on the page, it is useful to select 
the Separate Nets function. This splits the net into parts. 
Right-click on the net and choose “Separate Nets”.

In a real-life situation where many thousands of copies of a 
product are made, saving material in this way is environmen-
tally friendly and makes economic sense.

All these nets have been separated allowing 
better use of the available space

Right-click net menu
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Orthographic Projection
An orthographic projection comprises six views of an object: front, back, right side, left side, top, and bottom.

However, it is common to only use three of these views when drawing 1st or 3rd angle projection. Here are all six 
views of the model of a mansion building drawn from simple 3D shapes in Silhouette ModelMaker™.

Top view Front view Right side view

Bottom view Back view Left side view

An orthographic projection includes the front and plan views of 
an object and will include either or both the left and right hand 
sides as well. A projection would be complete when it includes 
the rear and bottom views too, making a total of six 2D views to 
illustrate the 3D object.

However, a standard drawing of an orthographic projection 
comprises just three views: front, side, and plan.

There are two ways to draw an orthographic projection: the 
3rd angle projection and the 1st angle projection. Both these pro-
jections are used to represent the model being drawn and differ 
from each other only in how the front and side views are posi-
tioned in the drawing.

A standard orthographic drawing 
normally comprises three views: front, 

top, and side. 

An orthographic projection will 
always be accompanied by a symbol 
to clearly show which projection has 
been drawn. This is normally placed 
at the bottom of the drawing. A 
3rd  angle projection will be indicated 
by the symbol shown here.

Quick Tip

Whether your 3D model is big or small, its 
1st or 3rd angle projection can be scaled to 
neatly fit the page.

3rd Angle Projection
The 3rd angle projection is the most favored of the 
two projections and is commonly seen on technical 
and architectural drawings in the USA and in the UK. 
ModelMaker can display the 3rd angle projection with 
either the left or right views, or with both. Students 
display the projections rendered in color, with white 
and black lines, or as line drawings with the hidden 
lines included.

3rd angle projection
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An orthographic projection will always 
be accompanied by a symbol to clearly 
show which projection has been 
drawn, and this is normally placed at 
the bottom of the drawing. The symbol 
shown here is used to denote that an 
orthographic projection has been 
drawn in the 1st angle.

There has been endless controversy about which projection is the best one to use. The 3rd angle projection is 
considered more logical in its layout and has always been the standard in USA. With the exception of the UK, 
the 1st angle projection is still the standard in Europe.

Quick Tip

3rd angle projections are used in the USA, 
UK, and Canada, whereas in Europe pro-
jections are usually 1st angle.

1st Angle Projection
The 1st angle projection displays the same drawings as 
the 3rd angle projection. The difference is found in the 
way the views are arranged.

It is easy to see why the 1st angle projection is seen 
by some as illogical. When the projection is displayed 
showing the right view, the view is actually placed on 
the left. Also, the top view is placed at the bottom.  

However, the 1st angle projection is still the standard 
projection for technical and architectural drawings in 
Europe.

First angle projection (showing the left view on the right)

Right-click on a projection to display different options for drawing it on 
the screen. All models can be drawn in 1st and 3rd angle projections, a 
choice of seven single-view projections, in color, a black line drawing, or 
a line drawing with hidden lines included.

All the different projections can be toggled between the different 
styles of drawing shown on the left:

1. Solid color or texture.

2. Black outline.

3. Black outline with all the hidden lines showing.

Quick Tip

Right-click on a projection in ModelMaker and 
choose how to display it.

Solid color or texture

Black outline

Hidden lines
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Print & Cut
Modelmaker prepares pages for a Print & Cut with a Silhouette machine. The Print & Cut function adds a set of 
Registration Marks for the Silhouette to read.

The Print & Cut window is like the Print window, but when the printing is complete it will offer options and 
instructions to cut the page just printed. Print & Cut is accessed via the fabrication option in the File menu or by 
clicking the Print & Cut button.

The page printed will have registration marks that the Silhouette machine will use to align the page prior to 
cutting the shape nets.

Print & Cut window

Section 6: Printing and Cutting 

The loading page contains instructions for loading the page into the Silhouette together with a diagram showing 
what the page looks like on the mat. To summarize these instructions:

There is one page remaining to be cut. 
1. Place Page 1 onto the mat as shown.

2. Load the mat into the Silhouette.

3. Continue.

A window at the bottom shows an image of the cutting machine with its identification and status. When the 
machine is switched on, the status will change to “ready”. 

Pressing the “Continue” button displays the registration page. Registration is needed in order to align the printed 
page properly on the Silhouette machine.

Loading the Silhouette
After the page has been printed, or if the print has been optionally skipped, the next page gives instructions for 
loading the Silhouette. Place the page onto a cutting mat and load it into the machine.

Print & Cut window—Loading the Silhouette
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Automatic Registration
To cut the nets accurately, the page must be properly aligned in the Silhouette. This happens when the Silhou-
ette automatically detects the registration marks and uses them to align the page.

The Silhouette machine will detect the registration marks automati-
cally. However, if there is a problem with auto-detection, there is also 
an option to detect them manually. 

When it is starts detecting registration marks, the machine searches 
for the first mark, detecting it with a small light detector on its carriage. 
It will then move to find the other two registration marks and will 
display a success or failure message.

If the message says the registration was successful, then you select 
the prompt to cut Page 1.

Continue the process until all the pages in the model have been 
printed and cut.

Automatic registration in process

Cut Settings
At the bottom of the “Loading the Silhouette” menu, there is an option to click the Settings link.

The Cut Settings default to Plain Cardstock. If you are using a different material, you can adjust the Speed, 
Thickness, and Blade Depth to work for your material.  

Cut Settings Window
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Manual Registration
To cut the nets accurately, the page must be properly aligned in the Silhouette machine. This happens when the 
Silhouette automatically detects the registration marks and uses them to align the page. 

As a rule the Silhouette will detect the registration marks auto-
matically, but if it fails there is an option to detect them manually.

To detect the registration marks manually, click on the arrows to 
move the carriage over the first registration mark indicated by the 
green square on the diagram. Once it is positioned, click “Detect 
Registration Marks”.

Quick Tip

To help ensure reliable detection of the registration 
marks, always load the printed page onto the mat so 
that the corner of the page fits squarely at the top 
left-hand corner of the mat’s grid. 

Detecting the registration marks manually

Preferences
Preferences may be updated by clicking on File > Preferences. Change your language or measurement units, 
choose your default orientation, customize the tool bars and more to make Modelmaker work for you. 

Section 7: Preferences



Website
Visit the tutorials section of www.silhouetteamerica.com for help.

Blog
Visit the official Silhouette blog at blog.silhouetteamerica.com for ideas of new projects you can create. Many 
blog posts contain step-by-step instructions for advanced uses of Silhouette products and software.

Newsletter
Sign up for the Silhouette newsletter at www.silhouetteamerica.com to receive product updates and special 
offers via email.

Customer Service
If you have any further questions, feel free to contact customer service:

Silhouette America, Inc.

support@silhouetteamerica.com

(800) 859-8243 (US only)

(801) 983-8937

Finding More Information
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